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10.

Maximum : 100 marks

Time : 1 hour and 30 minutes

Who is the present Vice Chairman of NITI Aayog?

(A) Suman Bery (B) Rajiv Kumar

(C) Aravind Panagariya (D) B.V.R. Subrahmanyan
The famous Hindu temple situated in the valley of Brahmagiri hill :

(A) Kottiyoor temple (B) Palani temple

(C) Thirunelli temple (D) None of these
In which of the following is a artificial lake?

(A) Dallake (B) Wular lake

(C) Gobind Sagar lake (D) Sambhar lake

In which session of Indian National Congress decided to observe 26t January of every year
as the Independence day?

(A) Nagpur session (B) Lahore session

(C) Bombay session (D) Amaravathi session

Wajid Ali Shah, the ruler of which one of the following states was removed from power by
British in the name of misrule at the time of 1857 Revolt?

(A) Awadh (B) Barout
(C) Arrah (D) Delhi
Mannath Padmanabhan organised Savarna Jatha in support of :
(A) Guruvayur Satyagraha (B) Paliyam Satyagraha
(C) Salt Satyagraha (D) Vaikkom Satyagraha
Who wrote the famous book ‘Prachina Malayalam’?
(A) Sree Narayana Guru (B) Chattambi Swamikal
(C) Vaghbhatananda (D) Swami Dayanand Saraswati
The best FIFA Men’s Player of 2022 :
(A) Christiano Ronaldo (B) Neymer
(C) Harry Kane (D) Lionel Messi
The town located on the confluence of river Bhagirathi and Alakananda is :
(A) Rudra Prayag (B) Dasa Prayag
(C) Vishnu Prayag (D) Karna Prayag
Who won the 52rd Odakuzzal award?
(A) Ambikasuthan Mangad (B) Sara Joseph
(C) Sethu (D) Mudnakudu Chinnaswamy
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Which of the following is the brain of the computer?

(A) Central Processing Unit (B) Memory
(C) Arithmetic and Logic unit (D) Control unit

Which of the following is an output device?
(A) Keyboard (B) Mouse
(C) Light pen (D) Printer

How many bytes does 2 kilobytes represent?

(A) 512 B) 1024
(C) 2048 (D) 256
Full form of URL is :
(A) Uniform Resource Locator (B) Uniform Resource Link
(C) Uniform Registered Link (D) None of these

Which operating system is developed by Apple?
(A) Linux (B) Window
(C) Mac OS (D) DOS

What is the name of a device that converts digital signals to analogue signals?
(A) Router (B) Switch
(C) Modem (D) Repeater

DPI means :

(A) Dots Processing Inch (B) Dots Per Inch
(C) Diagram Per Inch (D) None of these

Every computer connected to the internet is identified by a unique four-part string,
known as :

(A) IP address (B) Host name
(C) Domain name (D) None of the above

The Third-generation computers are based on :
(A) Transistor (B) Integrated circuit
(C) VLSI microprocessor (D) ULSI microprocessor

Malware is the short form for malicious software and used to refer to :
(A) Spyware (B) Worm
(C) Virus (D) All of the above
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is the special kind of website which offers so many services to its users.
(A) Web browsers (B) Web servers
(C) Web portals (D) None of these

1s an example of search engine.

(A)  Yippy (B) DuckDuckGo

(C) Bing (D) All of these
Touch Screen is ——————— Type peripheral Devices.

(A) Input (B) Output

(C) Memory (D) Both Input and Output
Norton 1s an example of ———— Software.

(A) Browser (B) Anti-Virus

(C) Search Engine (D) None of these

Who is the following is known as the father of computers?
(A) Dennis Ritchie (B) John Napier
(C) Charles Babbage (D) None of these

What do we call a collection of two or more computers that are located within a limited
distance of each other and that are connected to each other directly or indirectly?

(A) Internet (B) Intranet
(C) Local Area Network (D) Wide Area Network

What is meant by the concept of WYSIWYG in MS Word?
(A) What You See Is What You Get
(B) What You Seek Is What You Give
(C) What You See Is What You Give
(D) None of the above

Which commands are present in Quick Access Toolbar in MS Word?
(A) Save (B) Undo
(C) Redo (D) All of the above

Which of the following is an example of page orientation in word document?
(A) Landscape (B) Subscript
(C) Superscript (D) None of these
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To Select all the text in MS Word document by :
A Ctrl+S B) Ctrl+1
(C) Ctrl+A D) Ctrl+V

The name of a word document displays in :
(A) Ribbon (B) Title bar
(C) Status bar (D) Home tab

What is the shortcut key for “Find and Replace” dialog box in MS Word?
A Ctrl+F B) Ctrl+R
(C) Ctrl+H (D) Ctrl + Shift + F

What is the shortcut key for “Paste" in MS Word?
A Ctrl+V B) Ctrl+P
(C) Ctrl+S (D) Ctrl+E

In MS Word, which enables us to send the same letter to different persons?
(A) Mail merge (B) Macros
(C) Both (A) and (B) (D) None of the above

What is the default file name of Microsoft Excel file?
(A) Workbook.xlIsx (B) Workbook1.xlsx
(C) Worksheet.xlsx (D) Worksheet].xlsx

In MS Excel the intersection of a column and a row in a worksheet is called :
(A) Box B) Cell
(C) Range (D) Page Break

Which programming language is used to write a Macro in MS Excel?
@A C (B) C++
(C) dJava (D) Visual Basic

When a range is selected, how can you activate the previous cell?

(A) Press the Alt key (B) Press Tab
(C) Press Enter (D) Press Ctrl + G

In MS Excel what is the syntax for power function?

(A) Power (number, Power) (B) Power = (power, number)
(C) =Power (number, Power) (D) =Power (Power, number)
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In which function return the remainder after a number is divided by a divisor in EXCEL?

(A) ROUND () (B) TFACT ()
(C) MOD () (D) DIV ()

Which Chart can be created in Excel?

(A) Doughnut (B) Line
(C) Pie (D) All of the above

Excel displays the current cell address in the :

(A) Formula bar (B) Status Bar
(C) Name Box (D) Title Bar

Which of these is the page setup orientation by default of the slides in PowerPoint?

(A) Landscape (B) Portrait
(C) Vertical (D) None of the above

What is a Microsoft PowerPoint?

(A) Spreadsheet Program (B) Presentation Program
(C) Database Program (D) All of the above

Which of the following is called as page to create a presentation in PowerPoint?
(A) Sheet (B) Slide
(C) Document (D) None of the above

Which of the following shortcut key is used to start the slideshow?

(A) Using F5 key (B) Using F3 key
(C) Using F1 key (D) Using F6 key

Which of the following shortcut key is used to stop the slide show?

(A) Esc key B) Ctrl+0
(C) Ctrl+N D) Ctrl+ K

Which of the following shortcut key is used for help in PowerPoint?

A4) F1 B) F2
€ F3 D) F4

Which is the menu to create a text box on a slide?

(A) View -> Text Box (B) Tools -> Text Box
(C) Insert -> Text Box (D) Format -> Text Box

PowerPoint presentation is a collection of :

(A) Slides and Handouts (B) Speaker’s notes
(C) Outlines (D) All of the above
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51. Malayalam Typewriter was introduced by :
(A) K.N. Panicker (B) Kerala Government
(C) R. Arulappan (D) N.S. Pandala

52. Rhythmic touch method is also known as :
(A) Sight method (B) Staccoto method
(C) Legato method (D) All of the above

53. Type guide is fitted :
(1) at the bottom of the segment
(i1) at the top of the segment
(111) at the middle of the segment
Which statement is false in this statement?
(A) Only (111) (B) Only (1)
(C) Only () (D) None of the above

54. Items required for cleaning a typewriter :

(a) Long brush, Polishing cloth

(b) Oil can, hat pin

(¢c) Petrol, Soft rag

(d) Screw driver, Cleaning paste

Which of the following is true in this?

®  (a) and (b)

(11) (b) and (c)

(ii1) (c) and (d)

@iv) (d) and (a)
(A) only (1) and (i1) (B) only (i1) and (iii)
(C) only (iii) and (iv) (D) only (iv) and (i)

55. Rocher Mechanism includes the functioning of the following parts :
(1) Pinion wheel, Escapement wheel
(i1) Escapement wheel, loose dog
(i11) Pinion wheel, Segment slots
(iv) Loose dog, Platen

(A) Only (i) and (i) (B) Only (ii) and (iii)
(C) Only (iii) and (iv) (D) Only (v) and (i)
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From the below given statements, which options are true :

(1) When the machine is at rest, the loose dog is in action

(i1)) When the pressure on the rigid dog leaves the tooth and the loose dog catches the next
tooth of the escapement wheel

(i11) When the character key is pressed, rigid dog is in action.
(iv) Carriage moves by one degree when loose dog leaves the tooth of the escapement wheel
(A)  Only (1), 1) and (ii1)
(B) Only (i1), (ii1) and (iv)
(C)  Only (iv), (1) and (i1)
(D) All of the above

The ribbon starts to move from one spool to another spool automatically is known as :

(A) Reverse movement
(B) Automatic movement
(C) Automatic Reverse movement

(D) All of the above

The expanded form of EFTS :
(A) European Free Trade System

(B) Electronic Free Treasury System
(C) European Federal Temporary System
(D) Electronic Fund Transfer System

When the variable line spacer is used, the contact between the cylinder ratchet and the
cylinder is ceased.

The above statement shows that Variable line spacer is

(A) used to cease the cylinder
(B) used to rotate the cylinder
(C) Both (A) and (B) are correct
(D) Both (A) and (B) are false

The figure 370 is written in Roman Numerals as :
(A) CDXX (B) LLLDXX
(C) CCCLXX (D) CCXLL
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61. The publisher told me that my mistakes wouldn’t be a problem in the future. I thought he
was very kind, but later, I realized that he was giving me a left-handed compliment.

What does the idiom “a left-handed compliment” mean?
(A) Positive feedback
(B) Insulting remark
(C) Approval

(D) Encouragement

62. Give a one word substitute for “a sudden complete failure”.
(A) Debacle (B) Holocaust
(C) Malady (D) Nemesis

63. Find the word which is a synonym of “Cliche”.
(A) Stereotype (B) Novelty
(C) Creative (D) Original

64. Fill in the blank with a suitable preposition :

Negligence from the parents causes the children to look ——————— affection elsewhere.
(A at (B) in
(C) with (D) for

65. Find the figure of speech of the following sentence :
“My blood turned cold like the moon”.
(A) Metaphor
(B) Simile
(C) Personification

(D) Oxymoron

66. Pick out the sentence which is grammatically correct :
(A) Between you and me, everything is a mystery
(B) Between you and I, everything is a mystery
(C) Between I and you everything is a mystery

(D) Between you and he, everything is a mystery
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Fill in the blank with an apt phrasal verb :
Looking past in life, I still can’t
(A) Dragout B)
(C) Stand out (D)

Choose the correct spelling :
They performed the last
(A) rights B)

(C) writes D)

Identify the sentence which is in the passive voice :
(A) He has reserved his seat on the bus
(B) They had finished only half the work
(C) Let him be invited to the party
(D) I shall inform them of this

Choose the appropriate question tag :
He chose a book, —M—?

(A) Did he? (B)
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. What went wrong!

Figure out

Drop out

with all due respect, before the body was cremated.

rites

wrights

Isn’t he?
Won'’t he?

(C) Didn’t he?

Would you mind
(A) move

(C) moved

D)

your car from the way?

(B) moves

D)

moving

In the following sentence, supply a verb in agreement with its subject :

Either the casts or the director
(A) was
(C) are

responsible.
(B) were
(D) am

Mr. Bean saw a of keys lying on the floor.
(A) flock (B)

(C) bunch D)

group
bundle
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You must get some more questions, —————— You can’t complete your project.
(A) whereas (B) otherwise
(C) however (D) moreover
If T had known that you were coming, :
(A) I would have prepared your favourite dishes
(B) I would receive you at the railway station
(C) I will take you to some important destination
(D) I would ask you to bring some sweets
Fill in the blank with the correct reported speech :
She asked me
(A) if I needed lunch
(B) do you come with me
(C) does she visit this place often
(D) do you like pizza?
By the time we reached home, the thief ————— the spot.
(4) leave B) left
(C) leaves (D) had left
Fill in the blank using an article :
Ramesh is ————————— MBA graduate.
(A a (B) an
(C) the (D) of
His explanation was so complicated that only ——————— students responded to his queries
in the interactive session.
(A) afew B) little
(C) the little (D) alittle
Put the phrases in the correct order to unscramble the sentence :
the most interesting movies / I have ever seen / This is one of
(a) (b) (©
@A M) -(@ -© B)  (a)—®)—(c)
©) (©)—()-D) D) (b) —(c) - (a)
108/2024-M 12 A
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